Product Information

This document applies to IBM Cognos Business Intelligence Version 10.2.1 and may also apply to subsequent releases.

Licensed Materials - Property of IBM


US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
## Contents

### Chapter 1. Introduction

- System requirements for installing Cognos PowerPlay..................... 3
- Installing Cognos PowerPlay server............................ 4
- Setting up database connectivity for a DB2 content store..................... 5
- Creating a content store in IBM DB2 ............................. 6
- Saving your settings and starting the IBM Cognos Service.................... 6
- Configuring the web server ............................... 7
  - Use the CGI gateway on Microsoft Internet Information Services (IIS) version 7 or 8 .... 7
- Testing the server components ................................ 9
- Uninstalling the Cognos PowerPlay software ........................... 9

### Chapter 2. Cognos PowerPlay installation on one computer

- Creating a data source connection to the PowerCube samples.................. 11
- Importing the Cognos PowerPlay samples ............................ 11
- Testing a sample report ................................ 12

### Chapter 3. Installing the Cognos PowerPlay samples

- Keyboard Shortcuts for the Installation Wizard ........................ 13

### Appendix. Accessibility features

- Notices ................................... 15

### Index

© Copyright IBM Corp. 2005, 2013
Chapter 1. Introduction

This document is intended for use with IBM® Cognos® Business Intelligence PowerPlay®. Cognos PowerPlay is a web-based business intelligence solution with integrated data analysis and exploration features. It also includes a Windows-based client that you use to view, explore, format, and distribute reports.

This document provides the information you need to install and configure Cognos PowerPlay on a Microsoft Windows operating system using a single-server installation with default settings. This installation is the quickest and easiest way to get started and is suitable for setting up a test or evaluation environment.

For information about how to upgrade or install and configure Cognos PowerPlay on more than one computer or in a distributed installation, see the IBM Cognos PowerPlay Installation and Configuration Guide.

For information about migration and about the differences between IBM Cognos Series 7 PowerPlay and IBM Cognos PowerPlay, see the IBM Cognos PowerPlay Migration and Administration Guide.

Audience

To use this guide, you should be familiar with:

v database concepts
v basic Microsoft Windows operating system administration skills
v the existing server environment and security infrastructure in your organization

Finding information

To find IBM Cognos product documentation on the web, including all translated documentation, access one of the IBM Cognos Information Centers (http://pic.dhe.ibm.com/infocenter/cogic/v1r0m0/index.jsp). Release Notes are published directly to Information Centers, and include links to the latest technote and APARs.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility Features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products. This product has accessibility features. For information on these features, see “Accessibility features,” on page 13. IBM Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any
variation of the Sample Outdoors or Great Outdoors names, and Planning Sample
depict fictitious business operations with sample data used to develop sample
applications for IBM and IBM customers. These fictitious records include sample
data for sales transactions, product distribution, finance, and human resources.
Any resemblance to actual names, addresses, contact numbers, or transaction
values is coincidental. Other sample files may contain fictional data manually or
machine generated, factual data compiled from academic or public sources, or data
used with permission of the copyright holder, for use as sample data to develop
sample applications. Product names referenced may be the trademarks of their
respective owners. Unauthorized duplication is prohibited.
Chapter 2. Cognos PowerPlay installation on one computer

Installing and configuring IBM Cognos PowerPlay on a single computer using default settings is suitable for a test or evaluation environment.

This document provides instructions for the following type of Cognos PowerPlay installation:

- On a single computer running a supported version of a Microsoft Windows operating system
- Using either Cognos Content Database or IBM DB2® as the content store
- Using Apache Tomcat as the application server which is included with installation
- Using a supported web server on the computer installed with the Cognos PowerPlay software
- With no security enabled

If you are installing Cognos PowerPlay with IBM Cognos Business Intelligence server, install and configure IBM Cognos Business Intelligence server first. Both Cognos PowerPlay and the IBM Cognos Business Intelligence components must be the same version. For more information, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

For information about customizing the installation, distributing the components across multiple computers, using another database or application server, or about upgrading an existing installation, see the IBM Cognos PowerPlay Installation and Configuration Guide.

Additionally, you might want to install the Cognos PowerPlay samples that contain sales and marketing information for a fictional company named the Samples Outdoors Company. You can use sample packages and reports to help you learn how to use Cognos PowerPlay.

The installation process creates log files that include details about transferred files and installation errors. The log files are located in the c10_location\instlog directory.

System requirements for installing Cognos PowerPlay

Use the following tables to check the minimum hardware and software requirements to install and run IBM Cognos PowerPlay components on one computer.

Table 1. Hardware requirements to install Cognos PowerPlay

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
</tbody>
</table>
Table 1. Hardware requirements to install Cognos PowerPlay (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Disk space  | Minimum: 6.25 GB  
A minimum of 2.5 GB of free space is required to install the software and 4 GB of free space on the drive that contains the temporary directory used by IBM Cognos components.  
For all databases, the size will increase over time. Ensure that you have sufficient disk space for future requirements. |

Table 2. Software requirements to install Cognos PowerPlay

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web server</td>
<td>A web server must be installed and started.</td>
</tr>
</tbody>
</table>
| Database    | Cognos Content Database can be installed and configured as the default content store database in a test or proof-of-concept system.  
If you do not install the Cognos Content Database component, you can use another database, including IBM DB2, Microsoft SQL Server, Oracle, Sybase, or Informix®.  
This document includes steps for using Cognos Content Database and IBM DB2. For the other databases, see the IBM Cognos Business Intelligence Installation and Configuration Guide.  
TCP/IP connectivity is required for all database types. |
| Web browser | For all web browsers, the following must be enabled:  
• cookies  
• JavaScript  
For Microsoft Internet Explorer only, the following must be enabled:  
• Run ActiveX controls and plug-ins  
• Script ActiveX controls marked safe for scripting  
• Active scripting  
• Allow META REFRESH |

Installing Cognos PowerPlay server

In a single computer installation, IBM Cognos PowerPlay server is installed on the same computer as the other Cognos PowerPlay components.

Before you begin

Apply all required operating system patches and use only the versions of other software that are supported for an IBM Cognos product.

To review an up-to-date list of environments supported by IBM Cognos products, including information about operating systems, patches, browsers, web servers, and database servers, see the IBM Software Compatibility reports (www.ibm.com/support/docview.wss?uid=swg27037784).
You can install Cognos PowerPlay regardless of whether you have installed the IBM Cognos Business Intelligence software.

**Procedure**

1. Insert the IBM Cognos product disc or go to the location where the installation files were downloaded and extracted.
2. If the installation wizard does not start automatically, go to the operating system directory and double-click the `issetup.exe` file.
3. The language that you select determines the language of the user interface. You can change the language of the user interface to any of the installed languages.
4. On the **Component Selection** page, accept the defaults to install all the required components.
   - If you want to install the Cognos Content Database, select **Cognos Content Database**.
   - If you do not install Cognos Content Database, you can use an IBM DB2 database for your content store. Information for using a database other than IBM DB2 are provided in the *IBM Cognos Business Intelligence Installation and Configuration Guide*.
5. Follow the directions in the installation wizard.

**What to do next**

If you installed in a language other than English and want to see user documentation in the same language, you must install the translated user documentation from the Supplementary Language Documentation disc.

If you want to use the samples that are available for Cognos PowerPlay, see Chapter 3, “Installing the Cognos PowerPlay samples,” on page 11.

---

**Setting up database connectivity for a DB2 content store**

If you did not install the Cognos Content Database, you can set up database connectivity for a DB2 content store.

If you installed the Cognos Content Database, the database connectivity is already configured for you, and you can proceed to “Saving your settings and starting the IBM Cognos Service” on page 6.

**Before you begin**

DB2 must be installed.

**Procedure**

1. Stop the DB2 services and the HTML Search Server.
2. Copy the following files from the `DB2_installation\sql1\lib\java` directory to the `c10\location\webapps\p2pd\WEB-INF\lib` directory:
   - The universal driver file, `db2jcc.jar`.
   - The license file, `db2jcclicense_cu.jar`.
   - If you installed IBM Cognos PowerPlay to the default location, copy the files to the `C:\Program Files\ibm\cognos\c10\webapps\p2pd\WEB-INF\lib` directory.
3. Restart the DB2 services and the HTML Search Server.
Creating a content store in IBM DB2

The content store is a database that Content Manager uses to store global configuration data, global settings (such as the language and currency formats shown in the user interface), connections to data sources, and product-specific content.

If you install Cognos Content Database, you do not have to create a content store database.

**Before you begin**

The database user account must exist.

The DB2 library files must be copied to the `c10_location\webapps\p2pd\WEB-INF\lib` directory. For example, for DB2 9.7 Microsoft Windows operating system, copy the `db2jcc.jar` and `db2jcc_license_cu.jar` files from the `C:\Program Files\IBM\SQLLIB\java\` directory to the `c10_location\webapps\p2pd\WEB-INF\lib`.

**Procedure**

1. From the Windows Start menu, click IBM Cognos 10 > IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password.
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
5. In Database server and port number, enter the name of your computer and port number on which DB2 is running. For example, `localhost:50000`. 50000 is the default port number used by DB2.
6. Right-click Content Store, and click Generate DDL.
7. Click Details to record the location of the generated DDL file.
   - The DDL file named `createDB.sql` is created. The script is created in the `c10_location\configuration\schemas\content\db2` directory.
   - Use this script to create a database in IBM DB2. For more information about using a DDL file, see your IBM DB2 documentation.

**Saving your settings and starting the IBM Cognos Service**

You must save your configuration settings and start the IBM Cognos service before users can access IBM Cognos Connection, the product portal.

**Procedure**

1. From the Start menu, click IBM Cognos 10 > IBM Cognos Configuration.
2. Click File > Save to save your configuration settings.
3. Click Actions > Start.
   - It may take a few minutes for the IBM Cognos service to start.
   - If you have not configured the mail server information, click OK when prompted, and then click Continue to continue starting the services.
Configuring the web server

Before you use web pages generated by IBM Cognos Business Intelligence you must configure your web server. You must set up virtual directories to IBM Cognos Business Intelligence directories.

Procedure

Create the virtual directories shown in the following table:

<table>
<thead>
<tr>
<th>Alias name</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location\webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos\cgi-bin</td>
<td>c10_location\cgi-bin</td>
<td>Execute</td>
</tr>
</tbody>
</table>

- You can use a name other than ibmcognos in the aliases. However, you must use cgi-bin as the second part of the alias and you must change the virtual directory in the Gateway URI property in Cognos Configuration to match the new IBM Cognos alias.
- For Apache Web Server, ensure that you define the ibmcognos\cgi-bin alias before the ibmcognos alias in the httpd.conf file located in the Apache_installation\conf directory. The ibmcognos\cgi-bin alias must be defined as a ScriptAlias.

Use the CGI gateway on Microsoft Internet Information Services (IIS) version 7 or 8

If you are using Microsoft Internet Information Services (IIS) version 7 or later, use the following task to configure the CGI gateway.

The CGI gateway is provided for both 32-bit and 64-bit web servers.

About this task

If you are using Microsoft IIS as your web server and you plan to run more than one IBM Cognos BI product, or several instances of the same product, on one computer, you must create a separate application pool for each product or instance and then associate the aliases for that product or instance to the application pool.

For more information about creating an application pool, see your web server documentation.

Procedure

1. In the Microsoft Windows Control Panel, click Programs > Programs and Features.
   If you are using Microsoft Windows 8 or 2012 Server, Programs and Features is available directly from the Control Panel.
2. Click Turn Windows features on or off.
3. If you are using Microsoft Windows 2008 Server, use the following steps:
   a. Click Server Manager > Roles > Web Server (IIS).
b. Ensure that **Common HTTP Features**, or the features you require are enabled.

c. If CGI is set to **Not installed**, select CGI and click **Add Role Service**.

4. If you are using Microsoft Windows 2012 Server, use the following steps:

   a. In the Add Roles and Features Wizard, click **Role-based or feature-based installation**, and click **Next**.
   
   b. Select your server, and click **Next**.
   
   c. Select **Web Server (IIS)**, if it is not already installed, ensure that **Common HTTP Features** is selected, and click **Next** until you get to the **Role Services** section of the wizard.
   
   d. Expand **Application Development**.
   
   e. Select CGI if it is not already selected, and click **Next**.
   
   f. Click **Install**.

5. If you are using Microsoft Windows 7 or 8, use the following steps:

   a. Select **Internet Information Services** if it is not already selected.
   
   b. Expand **Internet Information Services > World Wide Web Services**.
   
   c. Ensure that **Common HTTP Features**, or the features you require are enabled.
   
   d. Expand **Application Development Features**.
   
   e. If CGI is not selected, select CGI.
   
   f. Click **OK**.

6. In the **Internet Information Services (IIS) Manager** console, under **Connections**, select your server name.

   - If you are using Microsoft Windows 2012 Server, in **Server Manager**, select **IIS**, and then right-click your server name, and click **Internet Information Services (IIS) Manager**.
   
   - If you are using Microsoft Windows 2008 Server, in **Server Manager**, expand **Roles > Web Server (IIS)**, and then click **Internet Information Services (IIS) Manager**.
   
   - If you are using Microsoft Windows 8, from the **Control Panel**, click **Administrative Tools** to access the **Internet Information Services (IIS) Manager** console.
   
   - If you are using Microsoft Windows 7, from the **Control Panel**, click **System and Security > Administrative Tools** to access the **Internet Information Services (IIS) Manager** console.

7. Double-click **ISAPI and CGI Restrictions**.

8. Under **Actions**, click **Add**.

9. Enter the path to the cognos.cgi file. The file is in the `c10_location\cgi-bin` directory.

   You must enter the full path, including the file name. If the path includes spaces, ensure you use quotation marks around the path. For example, enter:
   
   ```
   "C:\Program Files\ibm\cognos\c10\cgi-bin\cognos.cgi"
   ```

10. Enter a **Description**, such as CognosCGI.

11. Select **Allow extension path to execute**, and click **OK**.

12. Under **Connections**, expand **Sites**, and under your website, add the virtual directories as shown in the table:
Table 4. Required virtual directories

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location/webcontent</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>c10_location/cgi-bin</td>
</tr>
</tbody>
</table>

13. Select the cgi-bin virtual directory that you created.
14. Double-click **Handler Mappings**.
15. Under **Actions**, click **Add Module Mapping**.
   a. In **Request Path**, type cognos.cgi.
   b. In **Module**, select CgiModule.
   c. Leave **Executable (optional)** blank.
   d. In **Name**, enter a name for the entry, such as CognosCGI.
   e. Click **OK**.

**Results**

Users can access the CGI gateway by entering http://servername/ibmcognos in their web browsers.

**Testing the server components**

You can test your access to the portal using your Web browser. Accessing the portal will also verify whether your installation is running.

**Procedure**

1. Open a web browser.
2. Test the connection to the IBM Cognos Business Intelligence portal by typing the Gateway URI value from IBM Cognos Configuration. For example,
   http://host_name:port/ibmcognos/cgi-bin/cognos.cgi
   The default value for host_name:port is localhost:80 and ibmcognos is the virtual directory you created when you configured the web server.
   **Note:** You do not need to specify the port number, if using the default port number.
   It may take a few minutes for the web page to open. If you see the **Welcome** page of IBM Cognos Connection, your IBM Cognos Business Intelligence installation is working.

**Uninstalling the Cognos PowerPlay software**

If you no longer require IBM Cognos PowerPlay, you can uninstall all Cognos PowerPlay components.

**Before you begin**

To ensure all files are removed, close all programs before you uninstall the PowerPlay software.
About this task

When you uninstall Cognos PowerPlay components, files changed since installation, such as your configuration and user data files, are retained on the computer. You can use these configuration and data files when upgrading to a newer version.

The cognos_uninst_log.htm log file located in the \temp directory records activities associated with the uninstall process.

Procedure
1. From the Start menu, click Programs, IBM Cognos 10, Uninstall IBM Cognos, Uninstall IBM Cognos.
2. Follow the instructions to uninstall components.
3. Delete all temporary Internet files.
Chapter 3. Installing the Cognos PowerPlay samples

To use the samples, install them from the IBM Cognos Business Intelligence Samples disc or from the location where you downloaded and extracted the files.

About this task

The samples include data sources, models, cubes, reports, and other types of content, to support all IBM Cognos Business Intelligence components.

Procedure

1. Insert the IBM Cognos samples disc or go to the location where the installation files were downloaded and extracted.
2. Double-click the isetup.exe file.
   The Welcome page of the installation wizard appears.
3. Select the language to use for the installation.
4. Follow the directions in the installation wizard.
   Install the samples in a different directory than other IBM Cognos PowerPlay components.

What to do next

To set up the samples, you must create a data source connection and import the samples. After setting up the samples, you can use them to learn how to use the Cognos PowerPlay software.

Creating a data source connection to the PowerCube samples

IBM Cognos Business Intelligence PowerPlay uses data source connections to connect to the PowerCube samples and run sample reports or use sample packages. You must create a data source connection to IBM Cognos PowerCube to use the samples.

Procedure

1. Open IBM Cognos Administration by connecting to the IBM Cognos BI portal and clicking Administer IBM Cognos Content on the Welcome page.
2. Click the Configuration tab, and click Data Source Connections.
3. Click the new data source icon.
4. In the Name box, type great_outdoors_sales_en and then click Next. The name must be all lowercase and include the underscore characters.
5. In the connection page, select IBM Cognos Power Cube.
6. In the location box, type the path and file name for the great_outdoors_sales_en.mdc. For example, if you are creating a connection to samples installed to the default location on the local computer, type C:\Program Files\ibm\cognos\c10\webcontent\samples\datasources\cubes\PowerCubes\EN\great_outdoors_sales_en.mdc.
7. To confirm that you entered all parameters correctly, click Test the Connection.
8. On the Finish page, do not select Create a Package.
Importing the Cognos PowerPlay samples

To use the sample package and other content, you must import them from the sample deployment archive.

Before you begin

Before you import the content, ensure that you have created a data source connection to IBM Cognos PowerCube.

Procedure

1. Copy the IBM_Cognos_PowerPlay.zip file from the c10_location/webcontent/samples/content directory to the c10_location/deployment directory.
2. Connect to the IBM Cognos BI portal and on the Welcome page click Administer IBM Cognos Content.
3. On the Configuration tab, click Content Administration.
4. On the toolbar, click the New Import button.
5. In the Deployment Archive box select IBM_Cognos_PowerPlay.
6. Click Next.
7. In the Public Folders Content box, select the Samples folder.

Results

IBM_Cognos_PowerPlay appears in Content Administration and a Samples folder appears in Public Folders in IBM Cognos Connection.

Testing a sample report

To test that your samples were imported successfully, open a sample report in Cognos Viewer. Cognos Viewer is the default viewer when opening a report in IBM Cognos Connection.

Procedure

1. In IBM Cognos Administration, from the toolbar, click Launch, IBM Cognos Connection.
2. In the Public Folders list, open Samples, PowerPlay.
3. Click great_outdoors_sales_en.
4. Click any report in the list. The report opens in IBM Cognos Viewer.
Appendix. Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products.

See the IBM Accessibility Center (http://www.ibm.com/able) for more information
about the commitment that IBM has to accessibility.

Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster
method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system
navigation keys in addition to application-specific keys.

Note: The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some
of the main tasks in the installation wizard on the Windows operating system.

Table 5. List of keyboard shortcuts on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of
the main tasks in the installation wizard on the UNIX or Linux operating system.

Table 6. List of keyboard shortcuts on a UNIX or Linux operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of
the main tasks in the License Agreement page of the installation wizard.
Table 7. List of keyboard shortcuts on the License Agreement page

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a Windows operating system.

Table 8. List of keyboard shortcuts for IBM Cognos Configuration on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
<tr>
<td>Display the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Display the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Display the View menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Display the Actions menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Display the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a UNIX or Linux operating system.

Table 9. List of keyboard shortcuts for IBM Cognos Configuration on a UNIX or Linux operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
• Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
• Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
• UNIX is a registered trademark of The Open Group in the United States and other countries.
• Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.